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บทท่ี 4  
วิธีการสรา้ง Website 

 

4.1 โปรแกรมท่ีใช้ในการจดัทาํเวบ็ไซต ์
 
Macromedia Dream weaver MX เป็นโปรแกรมสรา้งโฮมเพจแบบเสมอืนจรงิ โดยไม่ตอ้งเขยีนเป็นภาษา 
HTML เอง หรอืทีศ่พัทเ์ทคนิคเรยีกวา่ "WYSIWYG" โปรแกรม Dream weaver มคีุณสมบตัแิบบลากแลว้วาง
และมเีครื่องมอื ช่วยในการสรา้งโฮมเพจอยา่งครบครนั และทีส่าํคญัคอื สามารถทาํงานรว่มกบัภาษาไทยได้
อยา่งด ีเมือ่เปิดโปรแกรมขึน้มาจะมสีว่นประกอบต่างๆ ดงัน้ี 

 Menu สาํหรบัเรยีกใชค้าํสัง่ต่างๆ โดยคลกิชื่อเมนูทีต่อ้งการทาํงาน 
 Object เป็นเครื่องมอืทีใ่ช ้Insert Tag คาํสัง่ต่างๆ ลงในโฮมเพจ เช่น ใสร่ปูภาพ ใสต่าราง สรา้ง  

เลเยอรเ์ป็นตน้ โดยสามารถทีจ่ะเปลีย่นไดอะลอ็กได ้โดยคลกิที ่Tab ของ Object  
 HTML Code Inspector สว่นของ Code และการจดัการไฟล ์ เป็นการออกแบบเวบ็ไซต ์           

ทีส่ามารถดูรปูแบบไดเ้หมอืนของจรงิทีป่รากฏบนเวบ็เพจหรอืตอ้งการเขยีน Code เป็นภาษา HTML เพื่อ
จดัการไฟล ์

 Tab File เมื่อเปิดไฟลห์ลายๆ ไฟลเ์พื่อทาํงาน ทุกไฟลท์ีเ่ปิดอยูจ่ะอยูใ่นโปรแกรมเดยีวโดยทาํ
เป็น Tab ไวด้า้นลา่งจะเลอืกใชไ้ฟลใ์ดกก็ดที ่Tab นัน้ 

 Properties เป็นการแสดงสถานะของ Object หรอื Tag ต่างๆ โดยจะคอยตดิตามการทาํงาน 
ทัง้น้ีกเ็พื่ออํานวยความสะดวกใหท้าํงานไดง้า่ยขึน้ เช่น ถา้ Click ทีร่ปูภาพกจ็ะเปลีย่นสถานะเป็น Image 
Inspector แสดงขอ้มลูของรปูภาพนัน้ แต่ถา้ Click ที ่ link กจ็ะแสดงขอ้มลูของ link นัน้ โดยสามารถแกไ้ขค่า
ต่างๆ ของ Object หรอืTag ต่างๆ ไดง้า่ย 
 

4.2 เครื่องมือจดัการและบริหารเวบ็ไซต ์
 
เน่ืองจากในการทาํเวบ็ไซตห์น่ึงๆ นัน้ ประกอบไปดว้ยหน้าโฮมเพจหลายๆ หน้า มไีฟลจ์าํนวนมากและแต่ละ
หน้ากจ็ะมลีงิคเ์ชื่อมโยง มเีน้ือหาทีต่่อเน่ืองถงึกนัอยู ่ดงันัน้เพื่อไมใ่หเ้กดิความสบัสนผดิพลาด Dream weaver 
จงึมเีครือ่งมอืทีม่คีุณสมบตัใินการจดัการบรหิารเวบ็ไซตซ์ึง่จะชว่ยในการทาํงานไดอ้ยา่งด ี
 
สิง่ทีส่าํคญัในการใชง้าน Dream weaver คอื ตอ้งสรา้งโฟลเดอรไ์วส้าํหรบัการจดัเกบ็ไฟลโ์ฮมเพจทัง้หมดไว้
เพื่อใหก้ารทาํงานเป็นระบบ ดงันัน้ผูใ้ชง้านควรจะกําหนดชื่อเวบ็ไซตพ์รอ้มกบัระบุตําแหน่งทีต่ ัง้หรอืโฟลเดอร์
ของเวบ็ไซตน์ัน้ๆ ก่อนเสมอ ไมว่า่เวบ็ไซตจ์ะมเีพยีงโฮมเพจเพยีงหน้าเดยีว หรอืหลายหน้ากต็าม โดยขัน้ตอน
ในการกาํหนดเวบ็ไซตม์ดีงัต่อไปน้ี 
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 4.2.1 คลกิเมนู Site เลอืก New Site หลงัจากนัน้คลกิ Tab Advanced เพื่อกําหนดชื่อพรอ้มทีต่ ัง้ของ
เวบ็ไซต ์ โดยใสข่อ้มลูตรงช่อง Site Name เพื่อตัง้ชื่อ Site สว่นของ Local Root Folder ใหค้ลกิปุ่ม     
เพือ่กาํหนดทีต่ ัง้สาํหรบัเกบ็ไฟล ์
 
 
 
 
 
 
 
 
 
 
   
 
 

 
รปูท่ี 4.1 แสดงหน้าจอการตัง้ชื่อ Site  

 
4.2.2 จากนัน้จะขึน้วนิโดวด์งัภาพดา้นลา่งให ้Click ปุม่และตัง้ชื่อโฟลเดอรส์าํหรบัเกบ็ไฟล ์คลกิเลอืก

โฟลเดอรท์ีต่อ้งการเกบ็ไฟล ์ กดปุ่ม Open ดา้นล่างจอ เพื่อเขา้สูโ่ฟลเดอรน์ัน้และกดปุ่ม Select ทีห่น้าจอ
ดา้นลา่ง 
 
 
 
 
 
 
 
 
 
 

 
รปูท่ี 4.2 แสดงหน้าจอตัง้ชื่อโฟลเดอรส์าํหรบัเกบ็ไฟล ์



โครงการศกึษาและพฒันาระบบเทคโนโลยสีารสนเทศและระบบฐานขอ้มลูในระยะที ่1 ของ   4-3 
ภาควชิาการวางแผนภาคและเมอืง คณะสถาปตัยกรรมศาสตร ์สถาบนัเทคโนโลยพีระจอมเกลา้เจา้คุณทหารลาดกระบงั 

 
 

 
 ดร.ประพทัธพ์งษ ์อุปลา (หวัหน้าโครงการ) 

คณะสถาปตัยกรรมศาสตร ์สถาบนัเทคโนโลยพีระจอมเกลา้เจา้คุณทหารลาดกระบงั 

 4.2.3 หลงัจากคลกิปุ่ม Ok แลว้จะกลบัมาสูห่น้าการทาํงานของโปรแกรม โดย Site ทีผู่ใ้ชง้านสรา้งไว้
สามารถดไูดจ้ากหน้าต่างดา้นขวามอืสว่นของ Files จะแสดงรายละเอยีดของไฟล ์โฟลเดอรต่์างๆ 
 
 
 
 
 
 
 
 
 
 

 
รปูท่ี 4.3 แสดงหน้าจอรายละเอยีดของไฟล ์โฟลเดอร ์

 
4.2.4 สรา้งไฟลเ์อกสารขึน้มา 1 ไฟล ์โดยการ Click ที ่File >New File และให ้Save ชื่อ index.html 

ซึง่ไฟลน้ี์จะเป็นเวบ็เพจหน้าแรกของเวบ็ไซตซ์ึง่จาํเป็นตอ้งตัง้ชื่อ File เป็น index.html เสมอเพราะ Browser 
จะอ่าน Fileindex.html ก่อนเป็นอนัดบัแรก และหลงัจากนัน้ถงึจะLink ไปยงั File งานอื่นซึง่จะตัง้เป็นชื่ออะไร  
กไ็ด ้ โดยต้องมนีามสกุลเป็น .html เสมอ ตวัอย่างการตัง้ชื่อไฟล์ aboutme.html index_profile.html 
couse325.html 
 *** การตัง้ชื่อไฟล ์ขอ้ควรระวงัสาํหรบัการตัง้ชื่อไฟลส์าํหรบัใชใ้น Server ของมหาวทิยาลยั 

 ตัง้ชื่อไฟลเ์ป็นภาษาองักฤษทัง้หมด และเป็นตวัอกัษรตวัเลก็ 
 ไมใ่หม้ชีอ่งวา่งระหวา่งชื่อไฟล ์หรอืถา้ตอ้งการเวน้ชอ่งวา่งควรใชเ้ครือ่งหมาย _ แทน 
 เมื่อมกีาร save ไฟลใ์หพ้มิพน์ามสกุลของไฟลเ์ป็น .html เสมอ สาํหรบัภาพทีใ่ชใ้นเวบ็ไซต์

นามสกุลของไฟลเ์ป็น .jpg หรอื .gif 
 4.2.5 ควรมกีารตัง้โฟลเดอรส์าํหรบัเกบ็ภาพทีใ่ชใ้นเวบ็ไซตเ์พื่อไมใ่หป้ะปนกบัไฟล ์HTML ทีผู่ใ้ชไ้ด้
สรา้งไวเ้ช่น สรา้งโฟลเดอร ์ images (สญัลกัษณ์ของโฟลเดอร)์ สาํหรบัวธิสีรา้งโฟลเดอรใ์หค้ลกิขวาที ่Site ซึง่ 
ผูใ้ชไ้ดส้รา้งไวแ้ลว้ จะปรากฏเมนูขึน้มาคลกิทีค่าํส ัง่ New Folder กจ็ะไดโ้ฟลเดอรใ์หมแ่ละเปลีย่นชื่อโฟลเดอร์
ตามทีต่อ้งการ 
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รปูท่ี 4.4 แสดงหน้าจอการตัง้โฟลเดอรส์าํหรบัเกบ็ภาพ 

 

4.3 การกาํหนดคณุสมบติัของหน้าโฮมเพจ 
  
คลกิเมนู Modify เลอืกคาํสัง่ Page Properties จะปรากฏหน้าจอดงัภาพ ทีช่่อง Title ดา้นบน พมิพข์อ้ความ
เพือ่เป็นชื่อหวัเรือ่งของหน้าโฮมเพจ ซึง่จะปรากฏอยูบ่นแถบดา้นบนของบราวเซอร ์
  
 
 
 
 
 
 
 
 
 
 
 
 

  
รปูท่ี 4.5 แสดงหน้าจอคาํสัง่ Page Properties 
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หรอืจะพมิพ ์Title ทีส่ว่นของ HTML Inspector กส็ามารถทาํไดเ้ชน่กนั 

  
Background Image เป็นการใชร้ปูมาทําเป็น background ถา้รปูมขีนาดเลก็ทางโปรแกรมจะจดัเรยีงเป็น 
Pattern เรยีงรปูซํ้ากนัเป็นแบบตาราง การกาํหนดคุณสมบตัเิกีย่วกบัการแสดงสบีนหน้าจอ มดีงัน้ี 

 สพีืน้ฉากหลงั (Background) 
 สตีวัอกัษรทัว่ไป (Text) 
 สตีวัอกัษรลงิค ์(Link) 
 สตีวัอกัษรลงิคข์องหน้าโฮมเพจทีเ่คยดมูาแลว้ (Visited Link) 
 สตีวัอกัษรลงิคข์ณะคลกิเมาส ์(Active Link) 

 
โดยคลกิในช่องสีเ่หลีย่มดา้นหลงัขอ้ความ Background กจ็ะปรากฏพาเลต็ต์ สขีึน้มาใหเ้ลอืกส ี โดยจะมสีใีห้
เลอืกทัง้หมด 216 ส ีเมื่อเลอืกไดส้ทีีต่อ้งการแลว้กค็ลกิเมาสอ์กีหน่ึงครัง้ ซึง่ภายในพาเลต็ตส์จีะมปีุ่มเลก็ๆ อยู่
สามปุม่ดว้ยกนั คอื 

 Eyedropper เป็นตวัชีเ้มาสร์ปูหลอดหยดส ีทีท่าํหน้าทีส่าํหรบัเลอืกสทีีต่อ้งการบนจอภาพ 
 Eraser เป็นปุม่สาํหรบัการยกเลกิการเลอืกสทีีเ่ลอืกไวก้่อนหน้าน้ี เหมอืนปุม่ Cancel 
 Color Button สาํหรบัแสดงพาเลต็ตท์ีล่ะเอยีดขึน้ 

เมือ่กาํหนดคุณสมบตัทิัง้หมดใน Page Properties เรยีบรอ้ยแลว้ ใหค้ลกิ OK กจ็ะเหน็วา่สขีองตวัอกัษรในหน้า
โฮมเพจน้ีไดเ้ปลีย่นไปแลว้ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รปูท่ี 4.6 แสดงหน้าจอคาํสัง่ Page Properties 
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4.4 การพิมพต์วัอกัษรและข้อความ 
 
การพมิพต์วัอกัษรและขอ้ความใน Dream weaver เหมอืนกบัการใช ้Microsoft Wordเราสามารถพมิพเ์ขา้ไป
ในหน้า Document ไดเ้ลย และลอง Preview ดโูดยการกด F12 (เป็นการจาํลองBrowser) เราจะเหน็ไดว้า่ 
ตวัอกัษรทีพ่มิพจ์ะเหมอืนกนักบัที ่Preview ทุกประการ 

 
4.4.1 การปรบัรปูแบบตวัอกัษร  
การปรบัรปูแบบตวัอกัษรสามารถทาํได ้โดยใช ้Properties Inspector Tool ดงัน้ี 
 Format เป็นรปูแบบของอกัษรสามารถเลอืกไดต้ามตอ้งการ 

  - Paragraph การพมิพแ์บบต่อเน่ือง 
  - Heading 1-6 การพมิพห์วัขอ้เรื่องตามขนาด Heading1 เป็นขนาดใหญ่ทีสุ่ดเรยีง
ตามลําดบั เป็นการใชเ้ลอืกก่อนพมิพ ์ แต่ถ้าพมิพไ์ปแลว้จะใชไ้ดโ้ดยการ Click Mouse คา้งแลว้ป้ายทัง้
ขอ้ความทีต่อ้งการจากนัน้มาเลอืกที ่ Properties > Format ตวัอกัษรกจ็ะเปลีย่นตาม สว่นตวัอกัษรทีไ่มไ่ด้
เลอืกกจ็ะไมม่กีารเปลีย่นแปลง 
  - ในหน้า Document เดยีวกนัเราสามารถใช ้ตวัอกัษรหลายแบบโดย Click ทีล่กูศรในช่อง
Default Font จะม ีFont อื่นใหเ้ลอืก สว่นค่า Default Font จะเป็น Font ทีไ่ดท้าํการ Set ไวใ้นตอนตน้ ซึง่ Font 
ทีนิ่ยมใชแ้ละสามารถอ่านภาษาไทยไดค้อื Ms Sans Serif, Verdana (สามารถกําหนด Font ไดม้ากกวา่ 1 
Font) 

 Size ขนาดของตวัอกัษร คลกิที ่   
 การใชต้วัหนา และตวัเอน ตวัหนา Click ที ่   และตวัเอน Click ที ่  
 การจดัให ้ชดิซา้ย ชดิขวา หรอืกึง่กลาง (เหมอืน Word ทุกประการ) 
 การใชห้วัขอ้ยอ่ย จะเป็นจุดหรอืตวัเลขกไ็ด ้
 เปลีย่นสตีวัอกัษรโดย Click ทีช่อ่งสีเ่หลีย่มจะมจีานสใีหเ้ลอืก 

 
 
 
  
 
 
 
 
 

รปูท่ี 4.7 แสดงหน้าจอคาํสัง่ Properties Inspector Tool 
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4.4.2 ข้อจาํกดัของการพิมพต์วัอกัษร   
 เน่ืองจากการพมิพไ์มส่ามารถเวน้วรรคตวัอกัษรไดเ้กนิหน่ึงตวัอกัษร จงึตอ้งมกีารเพิม่ Code ลง

ในโปรแกรม คอื คาํสัง่ Characters สาํหรบัการเวน้วรรค 1 ตวัอกัษร หรอืคลกิจากแทบ็ Insert 

 
รปูท่ี 4.8 แสดงหน้าจอคาํสัง่ Characters 

 
 การขึน้บรรทดัใหมโ่ดยการเคาะ Enter ในโปรแกรมจะเป็นการเวน้ 2 บรรทดัถา้หากตอ้งการเวน้

หน่ึงบรรทดัสามารถทาํไดโ้ดยการกด Shift คา้งพรอ้มทัง้กด Enter 
 
 

4.5 การใส่รปูภาพ 
 
คลกิปุม่ Image บนแทบ็ Insert ดงัรปู หรอืคลกิเมนู Insert แลว้เลอืกคาํสัง่ Image 

 

 
รปูท่ี 4.9 แสดงหน้าจอคาํสัง่ Image 

 
 จะปรากฏหน้าต่างดงัรปู ซึง่การเลอืกรปูภาพมจีากหลายแหลง่ทีต่อ้งการ ดงัน้ี 

 เลอืกรปูภาพจากโฟลเดอรอ์ื่นทีไ่มไ่ดอ้ยูภ่ายใต ้ Site ทีผู่ใ้ชก้ําหนด เช่น ตอ้งการเลอืกภาพจาก
Drive C โฟลเดอร ์ Gallery กดปุ่ม OK หลงัจากนัน้จะปรากฏหน้าต่างดงัรปู โดยโปรแกรมถามวา่ตอ้งการ
คดัลอกรปูภาพมา Siteทีผู่ใ้ชส้รา้งไวห้รอืไม ่ใหก้ดปุม่ Yes เพือ่คดัลอกรปูภาพ 

 หลงัจากนัน้โปรแกรมจะขึ้นหน้าจอให้เลือกโฟลเดอร์ที่ต้องการคดัลอกลงภายในไซต์ที่ผู้ใช้
กําหนดไวต้อนแรก โดยเริม่แรกผูใ้ชส้รา้งโฟลเดอร ์ Images สาํหรบัเกบ็รปูภาพไวแ้ลว้ จงึใหด้บัเบลิคลกิที่
โฟลเดอร ์images เพือ่เกบ็รปูภาพทีค่ดัลอกมาไวภ้ายใตโ้ฟลเดอรน์ัน้ และกดปุม่ Save รปูภาพทีเ่ลอืกไว ้

 เมื่อใส่รูปไดแ้ลว้และต้องการจดัรูปใหอ้ยู่กึ่งกลางของหน้าจอ หรอืกําหนดคุณสมบตัเิพิม่เตมิ
เกีย่วกบัรปูใหค้ลกิรปูภาพนัน้ และกาํหนดคุณสมบตัต่ิางๆ ของรปู โดยใช ้Properties 
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4.6 การทาํลิงค ์(Link) 
 

การทาํลงิคส์ามารถแยกเป็นประเภทใหญ่ๆ ไดส้องประเภทคอืการลงิคแ์บบ 
 Absolute Link : เป็นลงิคท์ีต่อ้งอา้งองิขา้มระหวา่งโดเมน เช่นการลงิคไ์ปยงัเวบ็ไซตอ์ื่น และ

จะตอ้งระบุชื่อโดเมนทัง้หมด เช่น ทาํการลงิคไ์ปที ่ สถาบนัเทคโนโลยพีระจอมเกลา้เจา้คุณทหารลาดกระบงั 

ตอ้งระบุคอื http://www.kmitl.ac.th ถงึจะสามารถลงิคไ์ด ้
 Relative Link : เป็นการลงิคภ์ายในเวบ็ไซตข์องเราเองการทาํลงิคส์ามารถจะทาํไดห้ลายวธิแีละ

สามารถทีจ่ะลงิคไ์ปยงัหน้าอื่นหรอืหน้าเดยีวกนักไ็ด ้
  

4.6.1 การทาํลิงคข้์อความ 
 เป็นการลงิคท์ีง่า่ยและไมยุ่ง่ยาก ก่อนทีจ่ะทาํลงิคจ์าํเป็นตอ้งสรา้งไฟลท์ีเ่ป็นเป้าหมายทีล่งิคไ์ป 
 (1) พมิพข์อ้ความทีต่อ้งการทาํเป็นลงิค ์เชน่ About Me 
 (2) ทาํ Highlight ขอ้ความ About Me 
 (3) ที ่Properties inspector ในชอ่งลงิคใ์หค้ลกิทีส่ญัลกัษณ์รปูโฟลเดอร ์
  (4) เลอืกไฟลท์ีต่อ้งการลงิคไ์ป เช่น aboutme.html แลว้คลกิ OK ทดสอบคลกิลงิคท์ีไ่ดท้าํไว ้โดยการ
กด F12 เพือ่ดผูา่น Browser 
 
 4.6.2 การลิงคไ์ปยงัเวบ็ไซตอ่ื์น 
 เราสามารถทีจ่ะทาํเวบ็ของเราเป็นเวบ็บรกิารหรอืรวมลงิคใ์หผู้อ้ื่นสามารถลงิคไ์ปยงัเวบ็ไซตอ์ื่นไดอ้กี
ดว้ยเพื่อสรา้งความหลากหลายในเวบ็ของเรา และยงัสะดวกกบัเจา้ของเวบ็เองอกีดว้ยโดยไมต่อ้งพมิพ ์ URL 
เขา้ไปใหม ่แต่สามารถคลกิทีเ่วบ็ของตวัเองกส็ามารถไปยงัเวบ็ทีต่อ้งการได ้เราอาจจะทาํลงิคเ์ฉพาะเวบ็ทีเ่รา
ใชบ้อ่ยๆ เชน่ เวบ็ไซตข์องมหาวทิยาลยั เวบ็ URSA เป็นตน้ โดยขัน้ตอนการทาํลงิค ์มดีงัน้ี 

 พมิพข์อ้ความทีต่อ้งการทาํลงิค ์เชน่ สถาบนัเทคโนโลยพีระจอมเกลา้เจา้คุณทหารลาดกระบงั 
 จากนัน้ใหป้้ายทบัขอ้ความ Bangkok University และมาที ่ Properties inspector ในช่อง Link  

ใหพ้มิพ ์URL เขา้ไปคอื http://www.kmitl.ac.th 
 กด F12 เพื่อดผู่าน Browser ใช ้Mouse ชีท้ีข่อ้ความ จากนัน้ใหส้งัเกตจาก Status bar ดา้นล่าง

จะระบุเวบ็ไซตท์ีถ่กูเชื่อมโยง แลว้ทดสอบคลกิทีล่งิคท์ีท่าํไว ้
 
 4.6.3 การทาํลิงคเ์มล ์(E-mail Link) 
 การทาํลงิคเ์มลส์ว่นมากจะเป็นการใหผู้ท้ีช่มเวบ็ไซตไ์ดต้ดิต่อกบัเจา้ของเวบ็ไซต ์กล่าวคอืเป็นการสง่
เมลธ์รรมดานัน้เอง แต่พเิศษอยูท่ีผู่ช้มไม่ตอ้งพมิพท์ีอ่ยู่ E-mail Address ของเรา เพยีงพมิพข์อ้ความตชิม
เท่านัน้เหมอืนเป็นการสง่เมลอ์ตัโนมตัโิดยไมต่อ้งไปทีผู่ใ้หบ้รกิารเมล ์ โดยหลงัจากคลกิลงิคเ์มล ์ Browser จะ
เปิดโปรแกรมสง่เมลใ์หโ้ดยอตัโนมตั ิสว่นมากถา้เป็น IE จะเปิดโปรแกรม Outlook ให ้โดยวธิลีงิคเ์มล ์มดีงัน้ี 

 พมิพข์อ้ความทีต่อ้งการลงิคไ์ปยงั E-mail เชน่ Email หรอื คาํวา่ ”Contact me” 
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 จากนัน้ใหป้้ายทบั E-mail Address และมาที ่ Properties inspector ในช่อง Link ใหพ้มิพ ์ E-
mail Address ทีต่อ้งการทาํลงิค ์เชน่ mailto:kuprapat@kmitl.ac.th 

 หรอือกีวธิคีอืเลอืก Object ที ่Email Link ภายในแทบ็ Insert ใหก้าํหนดดงัน้ี 
 
 
 
 
 

 
 
 

รปูท่ี 4.10 แสดงหน้าจอคาํสัง่ Email Link 
 
 จะปรากฏ Dialog Box ดงัรปูText ใหใ้สข่อ้ความ คาํตชิมE-mail ใหใ้สท่ีอ่ยูข่องเมลค์ลกิ OK 
 จากนัน้ทดสอบโดยการกด F12 แลว้คลกิขอ้ความ จากนัน้โปรแกรมจะเรยีกโปรแกรม Outlook

ขึน้มาใหใ้สข่อ้ความ จากนัน้คลกิสง่ (send) 
 
 4.6.4 การใช้รปูภาพเป็นลิงค ์

 คลกิ Image จากแทบ็ Insert 
 เลอืกรปูจาก Dialog box คลกิ OK 
 คลกิทีร่ปูภาพที ่ Insert มา และที ่Properties ในช่องลงิคใ์หค้ลกิปุ่ม จากนัน้เลอืกไฟลท์ีต่อ้งการ

ลงิคไ์ปหาหรอืจะลงิคไ์ปยงัเวบ็ไซตอ์ื่นภายนอก 
 
 4.6.5 การทาํลิงคใ์นหน้าเดียวกนั 
 เป็นการลงิคภ์ายในเวบ็เพจเดยีวกนัใชใ้นกรณีทีม่หีวัขอ้ยอ่ยหลายหวัขอ้และแต่ละหวัขอ้มเีน้ือหามาก
เพือ่ชว่ยใหส้ะดวกในการคน้หาหรอืเขา้ถงึขอ้มลู โดยขัน้ตอนการทาํดงัน้ี 

 พมิพข์อ้ความทีต่อ้งการ 
 ตัง้ชื่อ Anchor 
 ป้ายทบัขอ้ความและมาที ่ Properties inspector ในช่อง Link ใหพ้มิพ ์ # ตามดว้ยชื่อ Anchor 

ทีต่ ัง้ไวเ้ชน่ Pic1 
 กด F12 และลองคลกิทีล่งิค ์สงัเกตวา่หลงัจากทีค่ลกิ หน้าเพจจะเลื่อนมายงั Picture ทีไ่ดท้าํลงิค์

ไวโ้ดยอตัโนมตั ิ
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4.7 การสร้างตาราง (Table) 
  

(1) เลอืกตําแหน่งทีต่อ้งการใสต่าราง ดว้ยการวางเคอรเ์ซอรท์ีต่ําแหน่งนัน้คลกิปุ่ม Table ในแทบ็ 
Insert หรอืเลอืกเมนู Insert > Table 
 (2) จะม ีDialog box ขึน้มาใหก้าํหนดขนาดตารางและคา่ต่างๆ ดงัน้ี 
 
  Rows   จาํนวนแถวแนวนอน 
  Columns จาํนวนคอลมัน์ (แนวตัง้) 
  Width   ขนาดของตารางโดยรวม เลอืกไดว้า่จะใหห้น่วยเป็น percent หรอื Pixel 
  Border  กรอบของตาราง 
  Cell Padding ชอ่งวา่งระหวา่ง Cell กบัตวัอกัษรในเซลล ์
  Cell Spacing  ชอ่งวา่งระหวา่ง Cell 
 
 (3) Click OK จะมตีารางทีก่าํหนด ปรากฏทีห่น้า Document 
 (4) ถา้ตอ้งการปรบัขนาดของตาราง ทาํไดโ้ดยการคลกิทีข่อบของ Table ซึง่ Properties inspector 
จะเปลีย่นไปแสดงคุณสมบตั ิ(Properties) ของตาราง 
 

4.8 การบนัทึกและดโูฮมเพจ 
 
หลงัจากสรา้งโฮมเพจ สิง่ทีไ่มค่วรลมืกค็อืการบนัทกึผลงานทีไ่ดส้รา้งขึน้น้ีไวใ้นไฟลน์ามสกุล .htm หรอื html 
โดยตัง้ชื่อใหส้มัพนัธก์บัเน้ือหาภายในโฮมเพจ ทัง้น้ีจะไมท่าํใหเ้กดิการสบัสนไดใ้นภายหลงั ซึง่จะมผีลทําให้
งา่ยต่อการตรวจสอบ และจดัการเวบ็ไซตอ์กีดว้ย ขัน้ตอนการบนัทกึโฮมเพจมดีงัต่อไปน้ี 
 (1) คลกิทีเ่มนู File > Save หรอืกดปุม่ <Ctrl+S> 
 (2) เมือ่ปรากฏไดอะลอ็กบอ็กซ ์ใสช่ื่อไฟลข์องโฮมเพจ เชน่ "aboutme.html" ลงในชอ่ง File name 
 (3) ดบัเบิล้คลกิเมาสเ์ลอืกกาํหนดไดเรค็ทอรีท่ีต่อ้งการสาํหรบัเกบ็ไฟลใ์นชอ่ง Save 
 (4) คลกิปุม่ Save เพือ่บนัทกึไฟล ์
  

4.9 ข้อแนะนําในการทาํเวบ็ไซต ์
  

(1) การเลอืกเน้ือหาเวบ็ไซต ์ ถอืเป็นสว่นสาํคญัในการเริม่ตน้ทาํเวบ็ไซต ์ ทัง้การจดัโครงสรา้ง และ 
ความนิยมของเวบ็ไซต ์ สาํหรบัผูเ้ริม่ตน้ ซึง่ไมแ่น่ใจวา่จะเลอืกหวัขอ้ใด ควรเริม่ตน้จาก การสาํรวจตวัเองว่า 
ชอบ หรอื สนใจสิง่ใด มากทีส่ดุ หรอื มคีวามรูเ้ชีย่วชาญดา้นใดมากทีส่ดุ 
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(2) โครงสรา้งของเวบ็ไซต ์มจีุดมุง่หมายสาํคญัคอื การทีจ่ะทาํให ้ผูเ้ขา้เยีย่มชม สามารถคน้หาขอ้มลู 
ในเวบ็ไซต์ไดอ้ย่างเป็นระบบ ประการแรกตอ้งพจิารณาถงึ ความเป็นไปไดข้องประเภทของผูเ้ขา้เยีย่มชม
เพราะ   ผูเ้ยีย่มชมแต่ละประเภท กจ็ะคน้หาขอ้มลูทีแ่ตกต่างกนั ดงันัน้สิง่ทีค่วรจะทํากค็อืการจดักลุ่มของ
ขอ้มลูโดยใหร้วมหวัขอ้ยอ่ยต่างๆ ใหอ้ยูใ่นหวัขอ้หลกั โดยมจีุดมุง่หมายให ้จาํนวนขอ้หลกัน้อยทีส่ดุ นอกจากน้ี
การจดัไฟลแ์ละไดเรก็ทอรี ่ กจ็ะช่วยใหก้ารดูแลรกัษาและการตรวจสอบความผดิพลาดของเวบ็ไซตง์า่ยยิง่ขึน้ 
เชน่ การจดัไฟลร์ปูภาพไวท้ีเ่ดยีวกนั หรอื จดัเวบ็ไซตท์ีเ่ป็นเรือ่งเดยีวกนัไวใ้นไดเรก็ทอรีเ่ดยีวกนั เป็นตน้ 

(3) สามารถดเูวบ็ไซตไ์ดใ้นหลายบราวเซอร ์ การทาํเวบ็ไซตค์วรจะทาํเพื่อใหส้ามารถดไูดจ้ากทุกๆ
Version ของ Software ต่างๆ ไมว่า่จะเป็น Netscape Communicator Internet Explorer หรอื อื่นๆ การทาํให้
ทุกคนดไูดน้ี้ ถอืวา่เป็นการขยายฐานของผูเ้ขา้เยีย่มชม 

(4) ความเรว็ในการโหลดเวบ็ไซต ์ สาํหรบัหน้าแรกของเวบ็ไซตไ์มค่วรใหโ้หลดขอ้มลูชา้ ปจัจยัทีจ่ะ
กระทบต่อความเรว็ ไดแ้ก่ ขนาดของรปูภาพทีใ่ช ้ จาํนวนของรปูภาพทีใ่ช ้ และปรมิาณของตวัอกัษรทีอ่ยูบ่น
หน้านัน้ๆ อน่ึงความเรว็ในการโหลดเวบ็ไซต ์อาจอยูท่ี ่Server ทีเ่วบ็ไซตน์ัน้ๆ อยูว่า่มคีวามสามารถสงูเพยีงใด 
ขนาดของรปูภาพทีใ่ชค้วรจะมขีนาดไมเ่กนิ 20-30K ต่อรปู สว่นประเภทของรปูนัน้ควรเป็น GIF หรอื JPEG 
ถา้ขนาดของรปูภาพใหญ่เกนิไป อาจตดัแบง่ใหข้นาดเลก็ลง และใชต้ารางชว่ยในการจดัรปูภาพนัน้ๆ 

(5) ความงา่ยในการคน้หาขอ้มลู ปจัจยัหลกันัน้ขึน้อยู่กบัโครงสรา้งของเวบ็ไซต์ตัง้แต่ตอนแรกทีม่ี
การจดัโครงสรา้งและจดักลุ่มของขอ้มลู นอกจากน้ียงัมปีจัจยัอื่นๆ อกีเช่น การม ีNavigator bar หรอื แถบนํา
ทาง ในทุกๆหน้าของเวบ็ไซต ์และถา้สามารถใหบ้รกิาร Search และ Sitemap ไดก้จ็ะเป็นสิง่ทีจ่ะช่วยใหค้น้หา
ขอ้มลูไดง้า่ยยิง่ขึน้ 

(6) ตวัอกัษร ฉากหลงั และ ส ีสาํหรบัรปูแบบทีนิ่ยมใชค้อื ตวัอกัษรสดีาํ บนฉากหลงัขาว ถา้ตอ้งการ
กาํหนดประเภทของตวัอกัษรควรใชท้ีเ่ป็นสากลนิยม เช่น ในกรณีภาษาองักฤษ อาจใช ้Arial หรอืTimes News 
Roman เป็นตน้ สว่นภาษาไทย อาจใช ้MS Sans Serif การเลอืกใชต้วัอกัษรภาษาไทยนัน้ตอ้งระวงัเป็นพเิศษ
เพราะในกรณีทีเ่ครือ่งผูเ้ยีย่มชมไมม่ตีวัอกัษรนัน้ๆ อาจทาํใหผู้เ้ขา้เยีย่มชมไมส่ามารถอ่านตวัอกัษรไดเ้ลย 

(7) รปูภาพ มใีชก้นัอยู ่ 2 ประเภทคอื GIF หรอื JPEG หน่ึงในหลกัการพจิารณาการใชป้ระเภทเพื่อ
ประสทิธภิาพสงูสุด คอื จาํนวนสขีองรปูภาพนัน้ๆ ถา้เป็นภาพแต่งหรอืภาพถ่ายทีม่สีมีากๆ กค็วรใชไ้ฟล์
ประเภท JPEG แต่ถา้เป็นเพยีงปุ่มหรอืป้ายทีม่สีไีมม่ากกค็วรใช ้ GIF พรอ้มกบัพจิารณาเรื่องขนาดของไฟล์
ดว้ย อน่ึงควรจะมกีารคะเนขนาดของรปูภาพทีจ่ะใส่บนเวบ็ไซต์ก่อน เพื่อจะไดใ้ชข้นาด และอตัราส่วนที ่       
พงึพอใจมากทีส่ดุ 

(8) สว่นประกอบทีข่าดไมไ่ดข้องเวบ็ไซต ์ เช่น หวัขอ้ทีเ่กีย่วกบัผูจ้ดัทาํ อาจเป็นประวตัคิวามเป็นมา 
และ/หรอื ขอ้มลูปจัจุบนั (About us) เหล่าน้ีช่วยเพิม่ความน่าเชื่อถอืใหก้บัผูเ้ขา้เยีย่มชม และเพิม่เตมิเกีย่วกบั
แถบนําทาง Search Sitemap และยงัมหีวัขอ้อื่นๆ อกี เช่น ขอ้เสนอแนะ (Feedback) คาํถามทีถู่กถามบ่อย 
(FAQ - Frequently Asked Questions) 

(9) ก่อนที่จะนําเวบ็ไซต์ Upload ไปยงั Server ควรจะมกีารทดสอบ โดยใชท้ัง้ Netscape 
Communicatorและ Internet Explorer เพื่อดคูวามเรว็ในการโหลดวา่ชา้หรอืเรว็เพยีงใด Link ทัง้ภายใน และ 
ภายนอกถกูตอ้งหรอืไม ่รปูภาพถกูตอ้งหรอืไม ่พสิจูน์อกัษร และอ่านขอ้มลู เพือ่ใหแ้น่ใจวา่ขอ้มลูต่างๆ ถกูตอ้ง 
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(10) หลงัจากทีเ่วบ็ไซต์ Publish ถา้เป็นไปไดค้วรทดสอบ เหมอืนกบัทีท่ดสอบก่อนทีจ่ะ Publish 
เพื่อความแน่ใจอกีครัง้ นอกจากการทดสอบแลว้ สิง่ทีจ่ะตอ้งกระทาํหลงั Publish คอื การสาํรวจ ปรบัปรุง และ
ดแูลรกัษาเวบ็ไซต ์ เมื่อพบความคดิดีๆ  ทีอ่าจนํามาปรบัปรุงเวบ็ไซตไ์ดก้ค็วรจะจดบนัทกึไว ้ถา้เป็นการแกไ้ข
นิดหน่อยกค็วรทาํการแกไ้ขทนัท ี แต่ถา้เป็นการแกไ้ขทีต่อ้งใชเ้วลานานควรรอสกัระยะรวบรวมสิง่ทีต่อ้งการ
แกไ้ขทัง้หมด 


